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AHD DVR User Manual 
 
 
 
 
 
 
Welcome 

 
 
Thank you for purchasing our AHD DVR! 

 
This manual is designed to be a reference tool for the installation and operation 

of your system. Here you can find information about this series AHD DVR 

features and functions, as well as a detailed menu tree. Before installation and 

operation please read the following safeguards and warnings carefully! 
 
 
Important Safeguards and Warnings 

 
 
Do not place heavy objects on the AHD DVR. 

 
Do not let any solid or liquid fall into or infiltrate the AHD DVR. 

 
Please brush printed circuit boards, connectors, fans, machine box and so on 

regularly. Before the dust cleaning please switch off the power supply and unplug 

it. Do not disassemble or repair the AHD DVR by yourself. Do not replace the 

components by yourself. 
 
 
 
Environment 

 
 
Please place and use the AHD DVR between 0℃ and 40℃.Avoid direct sunlight. 

Stay away from heat source. 

Do not install the AHD DVR in damp environment. 
 
Do not use the AHD DVR in smoky or dusty 

environment. Avoid collision or strong fall. 

Please insure the AHD DVR level installation in a stable workplace. 
 
Please install in ventilated place. Keep the vent clean. Use within the rating input 

and output scope. 

 

This manual supports ET – 4AHD1, ET – 8AHD1, and ET -16AHD2 AHD DVR 
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1 Product Introduction 
 
 
 
1.1 Product Overview 

 
 
 
The series AHD DVR is designed especially for security and defense field which is an 
outstanding digital surveillance product. It introduces embedded LINUX operating system 
which is more stable. It introduces standard H.264 video compressed format and G.711A 
audio compressed format which insures the high quality image, low error coding ratio 
and single frame playing. It introduces TCP/IP network technology which achieves the 
strong network communication ability and telecommunication ability. 

 
 
The series AHD DVR can be used individually or online applied as a part of a safety 
surveillance network. With the professional network video surveillance software it 
achieves the strong network communication ability and telecommunication ability. 

 
 
The series AHD DVR can be applied in the bank, telecom, electric power system, 
judicial system, transportation, intelligent housing, factory, storehouse, water 
conservancy and so on. 

 

 
 
 
1.2 Main Functions 

 
 
 
Real-time Surveillance 
„ Analog interface and VGA interface (VGA interface is equipped 

selectively). 

„ Surveillance function through monitor or display. 
 
 
Storage 
„ Non-working hard disk dormancy processing which is convenient to radiate heat, 

reduce power and extend the life-span. 

„ Special storage format which insures the data safety. 
 
 
Compression 
„ Real-time compression by individual hard disk which insures the audio and video signal 

stable synchronization. 
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Backup 
„ Through SATA interface and USB interface such as USB equipment, removable hard 

disks and so on through net download the files in the hard disk. 
 
 
Playback 
„ Individual real-time video recording as well as searching, playback, network 

surveillance, recording check, downloading and so on. 

„ Multi-playback mode. 
„ Zoom at arbitrary region. 

 
 
 
 
Communication Interface 
„ RS485 interface which fulfills the alarm input and PTZ control. 
„ Standard Ethernet network interface which fulfills the telecommuting 

function. 
 
 
Intelligent Operating 
„ Mouse action function. 
„ Fast copy and paste operating for the same setting. 
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2      Open-package      Check      and      Cable   
Connections 

 
 
 
2.1 Open-package Check 

 
 
 
When you receive the AHD DVR, please check first .First; please check whether there is 

any visible damage to the package appearance. The protective materials used for the 

package of the AHD DVR can protect most accidental clashes during transportation. Then, 

please open the box and get rid of the plastic protective materials. Check whether there 

is any visible damage to the AHD DVR appearance. At last, please open the machine crust 

and check the data wire in the front panel, power wire, the connection between the fan 

power and the main board. 
 
 
Front Panel and Rear Panel 
„ The key function specification in the front panel and the interface 

specification in the real panel are in the specification. 

„ Please check the product type in the front panel whether is accordant with 
 

the product type you order. 
 
 
 
Note: The label in the real panel is very important for the after service Pleas protect it 

carefully When you contact us for after service please provided the product type and 

serial number in the label 
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2.2 Hard Disk Installation 
 
 

Before you use the DVR for the first time, the HDD should be installed in, 1/2/4 units of 
HDD can be installed according to the model of DVR. 

 
 
 
 
 
For the first use please install the hard disk. 

 

 

○1 disassemble the screw       ②disassemble the cover     ③fix the screw of hard disk 
 

 
④fix the screw of hard disk   ⑤connect the data wire       ⑥connect the power wire 

 
 

Name Description 
Video input Standard BNC port connected with the Camera. 

Video output Connected with the video input of the monitor. 
VGA VGA video signal output port connected with a VGA port of a 

computer monitor. 
Audio output Connected with earphone or cable speaker. 

Audio input port Connected to audio input device. 
“485” (AB) 

External alarm 
RS485, it can connect PTZ or decoder, and can Control PTZ 

via the panel, mouse, remote control and network. 
port Connected with alarm input and output. 
USB Connected to USB Pen-drive or mouse and used for system 

software upgrade or video file backup. 

NET RJ-45 network port connected to network cable and used for 
remote browse or control. 

Power Power input is DC 12V/5A (16 Channel DVR). Power input is 
12V/3A (4/8 channel DVR). 
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3 Basic Operation 
 
 
 
Note : The button in gray display indicates non-support. 

 
 
 
3.1 Turn On 

 
 
 
Plug the power supply and turn on the power supply switch. Power supply indicator light 
shining indicates turning on the video recorder. After the startup you will hear a beep. 
The default setting of video output is multiple-window output mode. If the startup time 
is within the video setting time, the timing video recording function will start up 
automatically. Then the video indicator light of corresponding channel is shining and the 
AHD DVR is working normally. 
1. Make sure that the input voltage corresponds with the switch of the AHD DVR 

power supply. 
2. Power supply demands: 220V±10% /50Hz. 
Suggest using the UPS to protect the power supply under allowable conditions. 

 
 
 
3.2 Turn Off 

 
 
 
There are two methods to turn off the AHD DVR. Entering <Main Menu> and choosing 
<Turn Off> in the <Turn off the system> option is called soft switch. Pressing the power 
supply switch is called hard switch. Illumination: 

 
 
(1) Auto resume after power failure. 

If the AHD DVR is shut down abnormally, it can automatically backup video and 
resume previous working status after power failure. 

(2) Replace the hard disk 
Before replacing the hard disk, the power supply switch in the real panel must be 
turned off. 

(3) Replace the battery . 
 
 
Before replacing the battery, the setting information must be saved and the power supply 
switch in the real panel must be turned off. The AHD DVR uses button battery. The system 
time must be checked regularly. If the time is not correct you must replace the battery, 
we recommend replacing the battery every year and using the same battery type. 
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Note : The setting information must be saved before replacing the battery otherwise 
information will lose. 
 
 
 

3.3 System Login 
 
 
 
When the AHD DVR boots up, the user must login and the system provides the corresponding 
functions with the user purview. There are three user settings. The names are admin, guest 
and default and these names have no password. Admin is the super user purview; guest and 
default’s permissions are preview and video playback. User admin and guest’s password can 
be revised, while their permissions can’t be revised; user default is the default login user 
whose permission can be revised but not its password. 
 

User Name: admin 
Password: No password 
Click OK to enter the system. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.1 System Login 
 

Note: Password protection: If the password is continuous wrong three times, 
the alarm will start. If the password is continuous wrong five times, the 
account will be locked. (Through reboot or after half an hour, the account 
will be unlocked automatically)   For your system security, please modify your 
password after first login. 

 
 
3.4 Preview 

 
 
You can right click mouse to choose the switch between the windows. 
The system date, time and channel name are shown in each viewing window. The 
surveillance video and the alarm status are shown in each window. 

Table 3.1 Preview icon 

1  Recording status 3  Video loss 

2  Motion detect 4  Camera lock 
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3.5 Desktop Shortcut Menu 
 
 
 

In preview mode you can right click mouse to get a desktop shortcut 
menu. The menu includes: Main Menu, Record Mode, PlayBack, PTZ 
Control, High Speed PTZ, Alarm Output, Color Setting, Output Adjust, 
Logout, View1/4/8/9/16 screens. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.2 Shortcut Menu 
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3.5.1 Main Menu 
 
 
When you login,and click on Main menu, the system main menu is shown as below. 
 

                           
 

Figure 3.3 Main Menu 
 
 
 
3.5.2 Playback 

 
 
There are two methods for you to play the video files in the hard disk. (1) In the 
desktop shortcut menu. 
(2) <Main menu> Æ <Record> Æ <Playback> 

 
 
Note: The hard disk that saves the video files must be set as read-write or 

read-only state. (4.5.1) 
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Figure 3.4 video playback 

 
1. Listed files                   2. File information.            3. File searching 
4. File backup                 5. Operation hint                6. Playback control 

 
 
<Listed files> Look up the listed files that accord with the searching criteria. 

 
 
<File information> Look up the found file information. 

 
 
<File backup> Backup the chosen file. Click the button and operate as followed. 

 
 
The storage must be installed before the file backup. If the backup is terminated, 

the already backup can playback 
individually. 
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Figure 3.5 detect the storage 

 

 
<Detect>  Detect the storage connected with the AHD DVR such as hard disk or 

universal disk. 
 
 
<Erasure> Choose the file to delete and click erasure to delete the file. 

 
 
<Stop> Stop the backup. 

 
 
<Backup>  Click backup button and the dialog box is popped up. You can choose the 

backup file according to the type, channel and time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.6 recording backup 
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<Remove> Clear the file information. 
 
 
<Add> Show the file information satisfying the set file attributes. 

 
 
<Start/Pause> Click the play button to start the backup and click the pause button to 

stop the backup. 
 
 
<Cancel> During backup you can exit the page layout to carry out other functions. 

 
 
<File searching> Search the file according to the searching parameter. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.7 file searching 
 
 
<File type> Set the searching file type. 

 
 
<Channel> Set the searching channel. 

 
 
<Start Time> Set the searching time scan. 

<Playback Control> Refer to the following sheet for more information. Table 3.2 

Playback control key 
 
 
Button                    Function                Button                    Function 

 

/                         Play/pause                                             Backward 
 

Stop                                                        Slow play 
 

Fast play                                                Previous 
frame 

 
Next frame                                             Previous file 
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Next file 
 
 
 

 

Circulation 

 Full screen  
 
 

 

 
Frame by frame playback is only performed in the pause playback state. 

 
 

<Operation hint> Display the function of the cursor place. 
 
 

Special functions: 
<Accurate playback> Input time (h/m/s) in the time column and then click play 

button. The system can operate accurate 
playback according to the searching time. 

 
 

<Local zoom>   When the system is in single-window full-screen playback mode, you 
can drag your mouse in the screen to select a section and then left 
click mouse to realize local zoom. You can right click mouse to exit. 

 
3.5.3 Record Mode 

 
 

Please check current channel status: “○” means it is not in recording status, 
“●” means it is in recording status. You can use desktop shortcut menu or click 
<Main menu> Æ <recording function> Æ <recording set> to enter the recording 
control interface. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.8 Record Mode 
 

 
<Schedule> Record according to the configuration. 

 
 

<Manual> Click the all button and the according channel is recording no matter the 
channel in any state. 

 
 

<Stop>   Click the stop button and the according channel stops recording no matter the 
channel in any state. 
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3.5.4 Alarm Output 
 
 

The Alarm output function is only possible in ET – 16AHD2. You can use desktop shortcut 
menu or click 
<Main Menu> Æ <Alarm Function> Æ <Alarm Output> to enter the alarm output 
interface. 

  
 

<Configuration> Alarm is on according to the configuration. 
 
 

<Manual> Click the all button and the according channel is alarming no matter the 
channel in any state. 

 
 

<Stop>  Click the stop button and the according channel stops alarming no matter 
the channel in any state. 

 
3.5.5 PTZ Control 

 

 
 

Operation interface is as followed. The functions include: PTZ direction control, step, 
zoom, focus, iris, and setup operation, patrol between spots, trail patrol, boundary 
scan, assistant switch, light switch, level rotation and so on. 

 
 
 

„ Decoder A (B) line connects with AHD DVR A (B) line. The connection is 
right. 

„ Click <Main menu> Æ<System configuration> Æ<PTZ setup> 
to set the PTZ parameters. 

„ The PTZ functions are decided by the PTZ protocols. 

 
Figure 3.9 PTZ Setup 

 
 
<Speed>   Set the PTZ rotation range. Default range: 1 ~ 8. 

 
 
<Zoom>   Click / button to adjust the zoom multiple of the camera. 

 
 
<Focus>   Click / button to adjust the focus of the camera. 

 
 
<Iris>   Click / button to adjust the iris of the camera. 
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<Direction Control>  Control the PTZ rotation. 8 directions control is supportive.(4 

directions in Front panel is supportive). 
 
 
<High Speed PTZ> Full-screen show channel image. Left press mouse and control PTZ to 

rotate orientation. Left press mouse and then rotate the mouse 
to adjust the zoom multiple of the camera. 

 
 
<Set> Enter the function operation menu. 

 
 
<Page Switch> Switch between different pages. 

 
 
 
Special functions: 

 
1.  Preset 

 
Set a location for the preset, calls the preset points, PTZ automatically turns to the 
setting position . 
 
 
1) Preset option Set a location for the preset, procedure is as follows: 

Step1:   in Figure 3.9, click the Direction button will turn into preset position, 
click the Settings button to enter Figure 3.10. 

Step 2:  click the Preset button, and then write the preset points in the input 
blank, 

Step 3:  click Settings button, return the Figure 3.9 Complete setup, that is the 
preset points and preset position corresponds. 

Clear Preset: Input preset points, click Remove button, remove the preset. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.10 Preset Setting 
 
2) Preset Point Calls 

 
In Figure 3.9, click Page Shift button, enter PTZ control interface as shown in Figure 3.11. 
In the input blank, write the preset points, then click Preset button, PTZ turn to the 
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corresponding preset point. Preset button Preset point input blank. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.11 PTZ Control 
 
 
 
2.  Cruise between Points 

 
Multiple preset points connected cruise lines, call cruise between points, the 
PTZ run around on the line. 

 
1) Cruise Between Points Settings 
Cruise lines are connected by multiple preset points, setting procedure is as follows: 

Step1:   In Figure 3.9, the Direction key will turn PTZ to designated location, 
click Settings button to enter Figure 3.12. 

 
 

Step 2:  Click Cruise buttons, the write proper value into the Cruise 
Line and Preset Points blank，then click Add Preset Points 
button, complete setting (also can add and delete cruise line which 
has been set up). 

 
 

Step 3:  Repeat step1 and step2, until set out all the preset designated cruise 
lines. 

 
 
Remove Preset: Please input preset value in the blank, click Remove Preset button, then 

remove the preset points. 
 
 
Remove Cruise Line: Input the number of cruise line, click Remove Cruise 

Lines button, then remove the cruise lines set. 
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Figure 3.12 Cruise Between Points Setting 

 
 
 
2) The Calls of Cruise between Points 

 
In Figure 3.9, click Page Shift button, enter PTZ control menu as shown in Figure 3.11. 
Please input the number of cruise in the value blank, then click Cruise between Points 
button, PTZ begins to work on the cruise line. Click Stop button to stop cruise. 

 
 
 
3.  Scan 

 
PTZ also can work on the preset scan line repeatedly. 

1) Scan setup 
 

Step1: In Figure 3.9, click Setup button enters Figure 3.13; 
 

Step2: Click Scan button，the input proper value in the scan value blank; 
 

Step3: Click Start button, enter Figure3.9，here you can set the following items: 
Zoom/Focus/Aperture/Direction and so on. Click Setup button to go back 
Figure 3.13; 

 
 

Step4: Click End button to complete setup. Click the right button of the mouse to 
exit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.13 Scan Setup 
 
2) Scan Calls 

 
In Figure 3.9, click Page Shift button, then enter PTZ control menu as shown in Figure 
3.11. Please input the number of scan in the value blank, and then 
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click Scan button，PTZ begins to work on the scan line. Click Stop button to 
stop. 

 
 
 
4. Boundary Scan 

 
1) Boundary Scan setup 

 
Step1: In Figure 3.9, click Direction button to turn the PTZ to preset direction, 

then click Setup button enter Figure 3.14, select the left boundary, 
return to Figure 3.9; 

 
 

Step2: Please click direction arrows to adjust PTZ direction, click Setup button 
enter Figure3.14, and then select the right boundary, return to Figure 
3.9; 

 
 

Step3: Complete setup, that is the position of left and right boundary 
 

 
Figure 3.14 Boundary Scan Setup 

 
 
2) Boundary Scan Calls 

 
In Figure 3.9, click Page Shift button, then enter PTZ control menu as shown in Figure 
3.11. Please input the number of scan in the value blank , then click 
Scan button，PTZ begins to work on the scan line . Click Stop button to stop. 

 
3) Horizontal Rotating 

 
Click Horizontally Rotating button, PTZ begins to rotate horizontally (relative to the 
original position of the camera) Click the Stop button to stop. 

 
 
 
4) Rotate 

 
Click on horizontal Rotating button, PTZ turn around. 

 
 
 



18 
 

5) Reset 
 
Line scan button border. PTZ restart, all the data clears to 0. 

 
 
 
6) Page Shift 

 
In Figure 3.11, click Page Shift button into Figure3.15, setting auxiliary function. 
Auxiliary number corresponding to auxiliary switch on the decoder. 

 

 
Figure 3.15 Auxiliary Function Control 

 
 
<Intuitive Auxiliary Operation> Choose auxiliary equipment, select Open or 

Close button, switch control. 
 
 
<Auxiliary Number> The operation of corresponding auxiliary switch according 

to PTZ agreement. 
 
<Page Shift> In Figure 3.15，click Page Shift button enter the Figure 3.9 

PTZ Main Menu , the menu itself can be control by the menu control 
buttons. 

 
3.5.6 Color Setting 

 
 
Set the selective image parameters (current channel for single window display and cursor 
place for multi-window display) You can use the desktop shortcut menu and enter the 
interface. The image parameters include: tonality, brightness, contrast, saturation. You 
can set different parameters at different time sections. 
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Figure 3.16 Color Setting 
 

3.5.7 Output Adjust 
 

 
Adjust TV output area parameters. You can use the desktop shortcut menu or enter <Main 
Menu> Æ <Management Tools> Æ <Output Adjust>. 
 
 
 
 
 
 
 
 
 
 

                                 
Figure 3.17 Output Adjust 
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3.5.8 Logout 

 
 
Logout shut down the system or reboot up. You can use the desktop shortcut menu or 
enter <Main menu>. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.18 Logout/Shutdown/Reboot the system 
 
 
<Logout> Quit the menu. Offer password next entrance. 

 
 
<Shut down> Quit the system. Turn off the power supply. When press the shutdown 

button, there is schedule hint. After three seconds, the system is shut 
down. Cancel midway is of no effect. 

 
 
<Reboot> Quit the system. Reboot up the system. 

 
3.5.9 Window Switch 

 

 
 
Preview in single window/four windows/eight windows/nine windows/sixteen windows 
according to your choice. 
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 4 Main Menu 
 

4.1 Main Menu Navigation 
 
 

Main Menu Sub Menu Functio
n 

 
 
 
Record 

 

Config Set the recording configuration, recording 
type, recording time section 

 

Playback Set recording look-up, recording play, video 
file storage 

 

backup Detect or format backup equipment, back 
the selective files 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Alarm 

 
 
Motion 
detection 

Set motion detect alarm channel, 
sensitivity, area, linkage parameters: 
defending time 
section, alarm output, screen hint, 
recording, PTZ, patrol 

 
Video blind 

Set camera mask alarm channel, 
sensitivity, linkage 
parameters: defending time section, alarm 
output, screen hint, recording, PTZ, patrol 

 
 
Video loss 

Set video loss alarm channel, 
linkage parameters: 
defending time, section, alarm output, 
screen hint, recording, PTZ, patrol 

 
 
Alarm input 

Set alarm input channel, equipment 
type, linkage 
parameters: defending time section, 
alarm output, screen hint, recording, 
PTZ, patrol 

Alarm output Set alarm mode: configuration, manual, 
shut down 

 

System 
configuration 

 

General 
configuration 

Set system time, data format, language, hard 
disk full time operation, machine number, 
video 
format, output mode, summertime, stay time 

 
 
Encode 
configuration 

Set main(assistant)coding parameter: code 
mode, resolving ability, frame rate, code 
stream control, 
image quality type, code stream value, 
frame between value, video/audio enable 

 

Network 
configuration 

Set basic network parameters, DHCP and DNS 
parameters, 
network high speed 
download 

Net Service 
 
PPPOE,NTP,EMAIL PREVIEW,DDNS 
PARAMETER,FTP,MOBILE MONITOR,WIRELESS 
CONFIG,WIFI,CLOUD 



 

 

  

 
GUI display 

Set channel name, preview hint icon state, 
transparency, cover area, time title, 
channel 
time foldPTZ 

configuration 
Set channel, PTZ protocol, address, baud rate, 
date bit, stop bit, check 

Serial port 
Configuration 
(RS232) 

 

Set serial port function, baud rate, date bit, 
stop bit, check 

Tour Set patrol mode and interval time 
 
 
 
 
 
 
 
 
 
 
 
 
 
Management 
tools 

 
 
Hard disk 
management 

Set appointed hard disk as read-write 
disc, read-only 
disc or redundant disc, clear data, resume 
date and so on 

User 
management 

Modify user, team or password. Add user or 
team. Delete user or team. 

 

 
Online user 

Break the connection with the already 
login user. Lock 
the account after, break until booting up again. 

 

TV adjust Adjust TV upside, downside, nearside, 
starboard distance 

Automatic 
maintenance 

Set automatic reboot system and 
automatic deleting files. 

 
 
 
Restore 

Resume setup state: common setup, code 
setup, 
recording setup, alarm setup, network setup, 
network service, preview playback, serial 
port, setup, user management 

 
 
 
 
 
System 
informatio
n 

Hard disk 
informatio
n

 

Display hard disk capability and recording time 

Code stream 
statistics 

 

Display code stream information 

Log 
informatio
n

Clear all log information according to the 
log video and time 

Edition 
informatio
n

 

Display edition information 

Shut down  Logout, shut down or reboot 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

22 



23 
 

4.2 Record 
 
 
 
4.2.1 Record Config 

 

 
 
Set the recording parameters in the surveillance channel. The system is set 24 hours 
consecutive recording in the first startup. You can enter <Main Menu> Æ <Recording 
function>Æ<Recording setup> to set. 

 
 
 
 
Note: There is at least one read-write hard disk.(refer to chapter 4.5.1) 
 

                            
    Figure 4.1 Record Config 

 
There is no Alarm configuration in ET-4AHD1and ET-8AHD1 
 
<Channel> Choose the corresponding channel number to set the channel. 

Choose the all option to set the entire channels.  
 
<Redundancy> Choose the redundancy function option to implement the file double 

backup function. Double backup is writing the video files in two 
hard disks. When you do the double backup, make sure that there 
are two hard disks installed. One is read-write disk and the other is 
redundant disk. (refer to 
4.5.1). 

 
 
<Length> Set the time length of each video file. 60minutes is default value. 
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<PreRecord> Record 3 seconds before the action. (Time length is decided by the code 
stream). 

 
 
<Record mode> Set video state: schedule, manual or stop. 

Schedule:  Record according to the set video type (Common, 
detection and alarm) and time section. 

Manual: Click the button and the according channel is recording no 
matter the channel in any state. 

Stop:   Click the stop button and the according channel stops 
recording no matter the channel in any state. 

 
 

<Period> Set the time section of common recording. The recording will start only in 
the set range. 

 
 

<Record type> Set recording type: regular, detection or alarm. 
 
 

Regular:  Perform the regular recording in the set time section. The 
video file type is “R”. 

Detect: Trigger the “motion detect”, “camera mask” or “video loss” 
signal. When above alarm is set as opening recording, 
the“detection recording” state is on. The video file type is “M”. 

Alarm:  Trigger the external alarm signal in the set time section. 
When above alarm is set as opening recording, the 
“detection recording” state is on. The video file type is              
“A”.Alarm type recording happens only in ET – 16AHD2 

    
 
Refer to chapter 4.3 to set corresponding alarm function. 

 
 

 
 

4.2.2 Playback 
 
 
Refer to chapter 3.5.2. 

 
4.2.3 Backup 

 
 
You can back up the video files to external storage through setup. 

 
 
 
Note: The storage must be installed before the file backup. If the backup is 
terminated, the already backup can playback individually. 
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Figure 4.2 Backup 
 
 
 
 
 
 
 
<Detect>  Detect the storage connected with the AHD DVR such as hard disk or 

universal disk. 
 
 
<Erase> Choose the file to delete and click erasure to delete the file. 

 
 
<Stop> Stop the backup. 

 
 
<Backup> Click backup button and the dialog box is popped up. You can choose the 

backup file according to the type, channel and time.
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Figure 4.3 File Backup 

 

 
<Remove> Clear the file information. 

 
 
<Add> Show the file information satisfying the set file attributes. 

 
 
<Start/pause> Click the play button to start the backup and click the pause button to 

stop the backup. 
 
 
<Cancel> During backup you can exit the page layout to carry out other functions. 

 
 
 
 
4.3 Alarm Function 

 
 
 
Alarm functions include: motion detect, video blind, video loss, alarm input and alarm 
output. 

 
 
 
4.3.1 Motion Detect 

 
 
When system detects the motion signal that reaches the set sensitivity, the motion 
detect alarm is on and the linkage function is turned on. 
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                                             Figure 4.4 Motion Detect 
 
 
<Channel> Choose the set motion detect channel. 

 
 
<Enable>   Means that the motion detects function is on. 

 
 
<Sensitivity> Choose in the six options according to the sensitivity. 

 
 
<Region >  Click setup and enter the set area. The area is divided into PAL22X18. Green 

block means the current cursor area. Yellow block means the dynamic detect 
defensive area. Black block means the unfenced area. You can set the area 
as followed, Drag the mouse and draw the area. 

 
 

 
Figure 4.5 Region 
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<Period>  Trigger the motion detect signal in the set time section. You can set according to 
week or set uniformly. Each day is divided into four time sections. ‘■’ means 
the set valid. 

 

 
Figure 4.6 set the time section 

 
 

<Interval> Only one alarm signal is turned on even there are several motions detect 
signals in the set interval. 

 
 

<Alarm output> Start the external equipment of corresponding linkage alarm when the 
motion detection alarm is turned on. 

 
 

<Delay>    Delay a few moments and stop when the alarm state is turned off. 
The range is 10~300 seconds. 

 
 

<Record channel>      Choose the recording channel (multiple options supportive)Trigger 
the video signal when the alarm is turned on. 

Note: Set in the <recording setup> and perform the linkage recording. 

Start detecting video files in the corresponding time section. 
 
 
 

<Tour>  Meaning that the selective channel is single window alternate patrol preview. 
The interval is set in the <Main Menu> Æ <System> Æ 
<Tour>. 
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<PTZ Activation>Set the PTZ activation when the alarm is turned on. 
 

Note: PTZ activation is set in the <Shortcut menu> Æ <PTZ control>. Set the patrol 

between spots, trail patrol and so on. 
 
 
 

 
Figure 4.7 PTZ Activation 

 
 

<Delay>  When alarm is over, recording will last some seconds (10~300sec), then stop. 
 
 

<Show message> Pop the alarm information dialog box in the local host computer 
screen. 

 
 

<Send EMAIL> Means to send an email to user when the alarm is turned on. 
 

 
   Note:  Set in the <Net Service> and send email. 

 
 
 

4.3.2 Video Blind 
 

 
 

When the video image is influenced by the environment such as bad brightness or 
reaching the set sensitivity parameter, the camera mask function is turned on and the 
linkage function is turned on. 
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Figure 4.8 Video Blind 
 

 
Set method: refer to chapter 4.3.1. Motion detect 

 
   Note: “Advanced” button is the same as right click. 

 
4.3.3 Video Loss 

 

 
When the equipment cannot obtain the channel video signal, the video loss alarm is 
turned on and the linkage function is turned on. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 4.10 Video loss 
 
 

   Figure 4.9 Video Loss 
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     Set method: refer to chapter 4.3.1. Motion detect  
 

 Note: “Advanced” button is the same as right click. 
 
 
 

4.3.4 Alarm Input 
 

 
 
When the equipment obtains the external alarm signal, the alarm function is turned 
on.This function supports only in ET – 16AHD2. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.10 Alarm Input 
 
 
Set method: refer to chapter 4.3.1. Motion detect 
  
Note : "Advanced" button is the same as right click. 

 

 
 
 
 
 
 
4.3.5 Abnormal 

 
 
Analyzing and inspecting current software and hardware of the device: When some 
abnormal events happen, the device will make a relative answer such as show message 
and buzzer. 
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Figure 4.11 Abnormal 

 
 
<Event Type> selecting abnormity you want to inspect. 

 
 
<Enable> Select it to make sure abnormal function workable. 

 
 
<Show message> Automatically alarm cue dialog box come out of the main screen. 

 
 
<Buzzer> Device will have two long voice “beep” while alarm is happening. 

 
 
 
4.4 System Setup 

 
 
 
Set the system parameters such as General, Encode, Net Work, Net 
Service, GUI Display, PTZ Config, RS232 and Tour Setup. 

 
4.4.1 General 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
Figure 4.12 General Setup 
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<System time> Set the system data and time. 
 
 
<Date format>  Choose the data format: YMD, MDY, and DMY. 

 
 
<Date Separator> Choose list separator of the data format. 

 
 
<Time Format> Choose time format: 24-hour or 12-hour. 

 
 
<Language>English, S-Chinese, T-Chinese, Italian,Spanish,French,Dutch,   
 
      Portuguese,Turkish,Poland,Hungarian 
 
<HDD full> Choose stop record: Stop recording when the hard disk is full. 

Choose overwrite: Cover the earliest recording files and continue recording 
when the hard disk is full. 

 
 
<DVR No. >   Only when the address button in the remote controller and the 

corresponding DVR number is matched, the remote operation is valid. 
 
 
<Video Standard> PAL or NTSC. 

 
 
<Auto Logout> Set the latency time in 0-60. 0 means no latency time. 

 
 
<DST> Choose the summer time option and pop the dialog box as followed. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.13 DST (Week) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.14 DST (Date) 
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4.4.2 Encode Setup 
 

 
 

Set the video/audio code parameter: video file, remote monitoring and so on. Set every 
independent channel’s coding parameter in the left part, and set the combine encode 
parameter in the right part. 

 
Note : Combine encode introduces video compression technique which combines and 

compresses multi-channel’s video to a 
special channel. Applying for Multi-channel playback simultaneously, Dial-up 
multi-channel real-time monitor, mobile monitor and so on. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.15 Encode setup 
 
 

<Channel> Choose the channel number. 
 
 

<Compression> Standard H.264 main profile. 
 
 

<Resolution> Resolution type: AHDM (720p), AHDL (960H),D1,CIF,QCIF. 
<Frame Rate> P: 1 frame/s~25 frame/s; N: 1 frame/s~30 frame/s.  

 
<Bit Rate Type> You can choose limited code stream or variable code stream. 

When you choose the variable code stream there are six image 
quality options. 

 
 

<Bit Rate> Set the code stream value to modify the image quality. The larger code 
stream value the better image quality. 
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<Video/Audio>   When the icons are all in reverse displayed, the video file is video and 
audio multiplex stream. Combine Enable. 

 
 
<Combine Enable> When the icons are all in reverse displayed, opening combination 

coding functions. 
 
 
<Mode>    Multi-channel playback is used in all channels playback simultaneously, 

and the narrowband transmission is used in multi-channel real-time 
remote monitoring simultaneously at narrowband state, especially 
used in mobile monitor. 

 

 
 
 
 
4.4.3 Network Setup 

 

 
 

 
Figure 4.16 Network 

 
 
<Net Card> You can choose cable network card or wireless network card. 

 
 
<DHCP Enable> Obtain IP address automatically (not suggested) DHCP 

server is preinstalled. 
 
 
<IP address> Set the IP address. Default: 192.168.1.10. 

 
 
<Subnet mask> Set the subnet mask code. Default: 255.255.255.0. 

 
 
<Gateway> Set the default gateway. Default: 192.168.1.1. 

 
 
<DNS setup> Domain Name Server. It translates the domain name into IP 

address. The IP address is offered by network provider. The 
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address must be set and reboot then it works. 
 
 
<TCP port> Default: 34567. 

 
 
<HTTP port> Default: 80. 

 
 
<HS Download> High Speed Download. 

 
 
<Transfer Policy> There are three strategies: self-adaption, image quality 

precedence and fluency precedence. The code stream will 
adjust according to the setup. Self-adaption is the tradeoff 
between the image quality precedence and fluency 
precedence. Fluency precedence and self-adaption are valid 
only when the assistant code stream is turned on. Otherwise 
image quality precedence is valid. 

 
4.4.4 Net Service 

 
 
Choose the network service option and click the set button to configure the 
advanced network functions or double click the service button to configure the 
parameters. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
                                        Figure 4.17 Net Service 
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<PPPoE Setup> 

 

 
Input the user name and password that ISP(Internet service provider) provides. After 
saving it reboot up your system. Then the AHD DVR will build a network connection 
based on PPPoE. The IP address will change into dynamic IP address after above 
operation is well done. 

 
Figure 4.18 

PPPoE 
 
 

Operation: After PPPoE dialing successfully look up the IP address in the 
<IP address> and obtain the current IP address. Then use this IP 

address to visit the AHD DVR through user port. 
 
 
<NTP setup> The NTP server must be installed in the PC. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.19 
NTP 

 
 
<Host computer IP> Input the IP address installed NTP server. 

 
 
<Port>   Default 123. You can set the port according to NTP server. 

 
 

<Time zone> London GMT+0 Berlin GMT +1 Cairo GMT +2 Moscow GMT +3 
New Delhi GMT+5 Bangkok GMT +7 Hong Kong Beijing GMT 
+8 Tokyo GMT +9 Sydney GMT +10 Hawaii GMT-10 Alaska 
GMT-9 Pacific time GMT-8 American mountain time GMT-7 
American mid time GMT-6 American eastern time GMT-5 
Atlantic time GMT-4 Brazil GMT-3 Atlantic mid time GMT-2.  
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<Update Period> The same with the NTP server check interval. Default: 
10minutes.  

 
<EMAIL setup> If the alarm is turned on or the alarm linkage photos are taken. 

Send an email about the alarm information and the photos to 
appoint address. 

 
Figure 4.20 EMAIL 

 
 
<SMTP Server> Email server address. It could be an IP address or domain name. 

Domain name can be translated only it is the correct DNS 
configuration. 

 
 
<Port> Email server port number. 

 
 
<SSL> Decide whether using Secure Socket Layer protocol to login. 

 
 
<User Name> Apply the email server user name. 

 
 
<Password> Input the password corresponding to the user. 

 
 
<Sender> Set the email sender address. 

 
 
<Receiver> Send the email to appointed receivers when the alarm is turned on. 

You can set three receivers at most. 
 
 
<Title> You can set as you wish. 

 
 
<IP Filter setup>   When choosing the white list, only the listed IP address can 

connect the AHD DVR. The 64 IP addressed are supportive 
in the list. When choosing the black list, the listed IP 
address cannot connect the AHD DVR. The 64 IP addressed 
are supportive in the list. You can delete the set IP address 
by √ in the options. 

 
 
 
   Note:         When the same IP address is in the white and black list at the same 

time, the black list precedence is higher. 
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Figure 4.21 IP FILTER 

 
 
<DDNS> It is the abbreviation of dynamic domain name server. 

 
 
<Local domain name> Provide the domain name registered by DDNS. 

 
 
<User name> Provide the account registered by DDNS. 

 
 
<Password>  Provide the password registered by DDNS. When the DDNS is 

successfully configured and start, you can connect the domain name 
in the IE address column to visit. 

 
Note: The DNS setup must be configured correctly in the network setup. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.22 DDNS setup 
 

 
<FTP Setup>   FTP is available only when alarm happens, or alarm activates record 

and snapshot, it will upload related record and napshot pictures to 
FTP server. 
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Figure 4.23 FTP setup 
 
 
<Enable> Click Enable, then all settings will be available. 

 
 
<Server IP> IP address for FTP server. 

 
 
<Port> Domain Port of FTP, default 21. 

 
 
<User Name> User name of FTP. 

 
 
<Password> Password of user. 

 
 
<Max File Length> Max length for upload files at every packed, default 128M. 

 
 
<Dir. Name> Directory of uploading files. 

 
 
<Wireless Config> ADSL through 3G net card, use CMS to visit and config the 

device. 

 
Figure 4.24 Wireless Config 

 
 
<Enable> Choose Enable to make all settings available. 

 
 
<Type> Dial type, default AUTO. 
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<Wireless AP> 3G access point. 

 
 
<Dial Number> 3G Dial Number. 

 
 
<User Name> User name of 3G. 

 
 
<Password>Password of dial user. 

 
 
<IP Address> IP address, got from dial. 

 
 
<Mobile Monitor Setup> To visit the device by mobile, plus make a router mapping of 

this port and use CMS to monitor and operate it by 
protocol. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.25 Mobile Monitor Setup 
 
 
<Enable> Select it to make sure abnormal function workable. 
<Port>    It’s a port of mobile monitoring which you need to make a router 

mapping of if want to visit it by mobile. 
 
 
<UPNP>   UPNP protocol can auto port forwarding on router, make sure 

UPNP is running on router before use it. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                            Figure 4.26 UPNP 
 
 
<Enable> Choose Enable to make sure all UPNP settings available. 
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<HTTP>    Route will automatically distribute HTTP port for the device, when 

IE viewing, it needs this port (e.g. 60.12.9.26:66) 
 
 
<TCP>      Router will automatically distribute TCP port for the device, when 

monitoring via CMS, it need this port. 
 
 
<Mobile Port> Router will automatically distribute Mobile Port for the device, when 

mobile monitor, it need this port. 
 
4.4.5 GUI Display 

 
 
 
Configure the video output parameters including the front output mode and code 
output mode. 

 
 
Front output: In the local preview mode include: channel title, time display, 

channel title, record status, alarm status, bit rate info, 
transparency and region cover. 

 
 
Code output: In the network surveillance and video file mode include: channel 

title,  
 
time display, channel title, record status, alarm status, bit rate info, 

transparency and region cover. 

 
 

 

 
 
 

 
 
 

 
 

 
 
 

Figure 4.27 GUI Display 
 
 
 
<Channel Title> Click the channel name modify button and enter the channel name 

menu. Modify the channel name. The 16 Chinese characters and 
25 letters are supportive. 
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<Time Display> Means the selective state. Display the system data and time in the 
surveillance window. 

 
 
<Channel Title> Means the selective state. Display the system channel 

number in the surveillance window. 
 
 
<Record Status> Means the selective state. Display the system recording status 

in the surveillance window. 
<Alarm Status> Means the selective state. Display the system alarm status in 

the surveillance 
window. 

 
 
<Bitrate info> Means the selective state. The ninth window displays the code stream 

information in the nine-window preview status. 
 
 
<Transparency> Choose the background image transparency. The range 

is128~255. 
 
 
<Resolution> Set display resolution. 

 
 
<Channel> Choose the set code output channel number. 

 
 
<Region Cover> Means the selective state. Click the cover area button and enter the 

corresponding channel window. You can cover the arbitrary 
using mouse. (Black region is for output) 

4.4.6 PTZ Setup  
 
 

 
Figure 4.28 PTZ setup 

 
 
<Channel> Choose the dome camera input channel. 

 
 
<Protocol> Choose the corresponding dome protocol. (PELCOD as an example) 

 
 
<Address > Set as the corresponding dome address. Default: 1. The address must be 

consistent with the dome address. 
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<Baud rate> Choose the corresponding dome baud rate length. You can control 
the PTZ. Default: 115200. 

 
 
<Data bits> Include 5-8 options. Default: 8. 

 
 
<Stop bits> Include 2 options. Default: 1. 

 
 
<Parity> Include odd check, even check, sign check, blank check. Default: 

void. 

4.4.7 RS232 Setup  
 
 

 
Figure 4.29 RS232 setup 

 
 
<Serial Port Function> Common serial port is used to debug and update program or 

set up specific serial port. 
 
 
<Baud rate> Choose the corresponding baud rate length. 

 
 
<Data bits> Include 5-8 options. 

 
 
<Stop bits>   Include 2 options. 

 
 
<Parity> Include odd, even, mark, space. 

 
 
 
4.4.8 Tour Setup 

 
 
Set the patrol display. You can choose the single window, four windows, nine 
windows; sixteen windows patrol display or single display. 
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Figure 4.30 tour setup 

 
 
<Interval> Set the patrol switch interval. The set range is 5-120 seconds, meaning turn 

off/on the patrol. 
 
 
 
 
 
 

4.5 Advanced 
 
 
 

4.5.1 HDD manage 
 
 

Configure and manage the hard disk. The menu displays current hard disk information: 
hard disk number, input port, type, status and overall capability. The operation include: 
setup the write-read disk, read-only disk, redundant disk, hard disk format, resume 
default. Choose the hard disk and click the right function button to execute. 

 
 
 
 Read/Write Disk: The equipment can write or read data. 
   Read-only Disk: The equipment can read data but cannot write data. 
   Redundant Disk: Double backup the video files in the write-read disk. 
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Figure 4.31 HDD Manage 

 
 
 
4.5.2 Account 

 
 
Manage the user purview. 
(1)  The character length is 8 bytes at most for the following user and user team 

name. The blank ahead or behind the character string is invalid. 
The middle blank in the character string is valid. Legal characters include: 
letter, number, underline, subtraction sign and dot. 

 
 

(2)  There is no limit in the user and user group. You can add or delete the user group 
according to user definition. The factory setup include: user\admin. You can set the 
team as you wish. The user can appoint the purview in the group. 

 
 

(3)  The user management includes: group and user. The group and user name 
cannot be the same. Each user only belongs to one group. 
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Figure 4.32 Account 

 
 

<Modify User> Modify the existed user attribute. 
 
 

<Modify Group> Modify the existed team attribute. 
 
 

<Modify Password> Modify the user password. You can set 1-6 bit password. 
The blank ahead or behind the char string is invalid. The middle 
blank in the char string is valid. 

 
 
 
Note: The user who possess the user control purview can modify his/her own or other 
users password 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.33 Modify Password 
 
 

<Add User>   Add a user in the team and set the user purview. Enter the menu interface 
and input the user name and password. Choose 
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the team and choose whether cover using the user. Cover using means 
that the account can be used by multiple users at the same time. Once 
choose the team the user purview is the subclass of the team. We 
recommend that the common user’s purview is lower than the advanced 
user. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.34 Add User 
 
 
<Add Group> Add a user team and set the purview. There are 36 different purviews: 

shut down the equipment, real time surveillance, playback, 
recording setup, video file backup and so on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.35 Add Group 
 
 
<Delete User> Delete the current user. Choose the user and click delete user button. 

 
 
<Delete Group> Delete the current group. Choose the group and click delete group 

button. 
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Figure 4.36 Delete Group 

 
 
 
4.5.3 Online User 

 
 
 
Look up the network user information in the local DVR. You can choose the network user 
and cut the connection. Then the user is locked until next 
boot-strap. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.37 Online User 
 
 
 
 
4.5.4 Auto Maintain 

 
 
The user can set the auto reboot time and auto file deleting time limit. 

 
Figure 4.38 Auto maintain 
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4.5.5 Restore 

 
 
The system restore to the default setup. You can choose the items according to the 
menu. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.39 Restore 
 
 
 
4.5.6 Upgrade  

 
 

 
Figure 4.40 Upgrade 
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<Upgrade> Choose USB interface. 
 
 
<Upgrade File> Choose the file which needs upgraded. 
 
4.5.7 Digital 

 
 
 
Digital includes digital channel, channel status and channel type mode. 

 
 
 
 
 

 
Figure 4.41 Mixed Mode  

 
(1)Digital Channels  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 4.42 Single-link Digital Channel 
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Figure 4.43 Multi-channel Digital 
 

<Channel>   Select channel title; 
<Enable>     Open digital channel, tick enable, then can do related settings; 
<Time Synchronization> Tick it means the time of this channel and device is the same. 
<Connection Mode> can be singe connect or multi-ink, multi-link modes can 

connect to several devices, device will be tour displayed one by one, tour 
interval can be set, no less then 10s; 

 
 
<Delete>        If the user want to change device, select the existing device, click 

delete will be ok. 
 
 
<Add>            Click add will come out below page to add new device: 

 
Figure 4.44 Remote Access Configuration 
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<Configur. Name> Device is with default config title, users can revise it as you like; 
 
 
<Device Type> There are three types: IPC, DVR, HVR, the user can choose as what you 

like, default is IPC; 
 
 
<Protocol>    System default is TCP protocol; 

 
 
<Remote Channel> Users can input remote channel title from the device that you want to 

connect remotely; 
 
 
<Stream>      User can input remote channel title from the device that you want to 

connect remotely; 
 
 
<Device address> IP address of device; 

 
 
<Port>           Default is 34567; 

 
 
<User name> Default is admin 
 
Note: Click the ‘Search’ button, will show all the devices that searched out, user can 
choose any of the device that you like. 
 
 
 
 

 
Figure 4.45 Remote Channel Configuration 

 
(2)Channel status 

 
 
Channel status is to show the status of all the digital channel, including Max 

 
Resolution, This Resolution, Connection Statu
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                        Figure 4.46 A ‘Unknown’ Status 
 

 
Figure 4.47 All-digital Channel Status 

 
 
Under all digital channel mode, Max resolution of channel 3 is AHDL, if it was 

connected to a device with resolution over AHDL ( such as AHDM), you will see 

below: 
 
 

 
Figure 4.48 A Red "X
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(3) Channel mode 
 
 

 
 

 

 

 

 

  

 
     
 
 
 
                  ET – 4AHD1                         ET – 8AHD1           ET – 16AHD2 
 
Figure 4.49 Channel Type 

 
The system support mode of 0+6, 4+2, 2+4, 0+4, 0+2 etc., user can shift the mode as 
they like.  
 
 
 
 
4.6 Info 
 
4.6.1 Device Info 

 
 
 
Provide device interface info like audio in, alarm in/out to be conveniently used for user. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.50 Device Info. 
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4.6.2 HDD Info 
 
 
 
Display the hard disk state: hard disk type, overall capability, residual 
capability, the recording time and so on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.51 HDD Info 
 
 
Clue: ‘○’ means that the hard disk is normal. ‘X’ means that the hard disk is broken-

down. ‘-‘ means that there is no hard disk. If the user needs to change the 
damaged hard disk, you must shut down the AHD DVR and take up all the 
damaged hard disks, then install a new one.   Behind serial number means the 
current working disk such as ‘1*’.   If the corresponding disk is damaged, the 
information will show “?”. 

 
4.6.3 BPS 
 
 
 
Display the code stream(Kb/S) and hard disk capability (MB/H) in real time. It displays as 
the wave sketch map. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.52 BPS 
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4.6.4 LOG 
 
 
Look up system log according to the set mode. Log information include: system 
operation, configuration operation, data management, alarm affair, recording operation, 
user management, and file management and so on. Set the time section to look up and 
click the look up button. The log information will display as a list. (One page is 128 items) 
Press Page up or Page down button to look up and press delete button to clear all the log 
information. 
 

 
Figure 4.53 LOG 

 
 
4.6.5 Version 

 
 
Display the basic information such as hardware information, software edition, and issue 
data and so on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.54 Version 
 
 



58 
 

 

5 FAQ and Maintenance 
 
 
 
5.1 FAQ 

 
 
 
If the problems are not listed, please contact the local service or call the HQ 
service. We are willing to offer the service.  

 
(1) The AHD DVR cannot boot up normally. 

Possible reasons are as followed: 
1 The power supply is not correct. 
2 Switch power supply line is not in good connection. 
3 Switch power supply is damaged. 
4 The hard disk is damaged or the hard disk lines are broken. 
5 The front panel is damaged. 
6 The main board of the AHD DVR is damaged. 

 
 
(2) The AHD DVR reboots automatically or stops working after boot up a few 

minutes. 
Possible reasons are as followed: 
1 The input voltage is not stable or too low. 
2 The hard disk is damaged or the hard disk lines are broken. 
3 The power of the switch power supply is low. 
4 Frontal video signal is not stable. 
5 Bad heat radiator or too much dust or bad running circumstance for the AHD 

DVR. 
6 The hardware of the AHD DVR is damaged. 

 
 
(3) System cannot detect hard disk. 

Possible reasons are as followed: 
1 The hard disk power supply line is not connected. 
2 The cables of the hard disk are damaged. 
3 The hard disk is damaged. 
4 The SATA port of main board is damaged. 

 
 
(4) There is no video outputs in single channel, multiple channels and all channels. 

Possible reasons are as followed: 
1 Check the connection or cable connected between camera and dvr. 
2 Check the camera type being connected to AHD DVR whether AHD or analog, change 
the AHD DVR setting as per camera type 
3 The image brightness is all 0. Please restore the default setup. 
4 There is no video input signal or the signal is too weak. 
5 The channel protection or the screen protection is set. 
6 The hardware of the AHD DVR is damaged. 
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(5) Real-time image problems such as the image color or the brightness distortion. 
Possible reasons are as followed: 
1 When using the BNC output, the option between the N mode or PAL 

mode is wrong and the image becomes black and white. 
2 The AHD DVR is not matched the monitor impedance. 
3 The video transmission distance is too far or the loss of the video 

transmission line is too large. 
4 The color and brightness setting of the AHD DVR is wrong. 

 
 

(6) I cannot find the video files in local playback mode. 
Possible reasons are as followed: 
1 The data line of the hard disk is damaged. 
2 The hard disk is damaged. 
3 The recording is not on. 

 
 
(7) The local video is not clear. 

Possible reasons are as followed: 
1 The image quality is too bad. 
2 The data line of the hard disk is damaged. 
3 The hard disk is damaged. 
4 The hardware of the AHD DVR is damaged. 

 
 

(8) There is no audio signal in the surveillance window. 
Possible reasons are as followed: 
1 It is not an active tone arm. 
2 It is not an active sound box. 
3 The audio lines are damaged. 
4 The hardware of the AHD DVR is damaged. 

 
 
(9) There is audio signal in the surveillance window but mo audio signal in the playback 

state. 
Possible reasons are as followed: 
1 Setting issues: the audio option is not chosen. 
2 The according channel is not connected with the video. 

 
 
(10) The time is wrong. 

Possible reasons are as followed: 
1 Setting is wrong.. 
2 The battery is in bad connection or the voltage is too low. 
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(11) The AHD DVR cannot control the PTZ. 
Possible reasons are as followed: 
1 There is something wrong with the frontal PTZ. 
2 The setting, connection or the installation of the PTZ decoder is not correct. 
3 The connections are not correct. 
4 The PTZ setting of the AHD DVR is not correct. 
5 The protocols of the PTZ decoder and the AHD DVR are not matched. 
6 The address of the PTZ decoder and the AHD DVR are not matched. 
7 When multiple decoders are connected, the far port of the PTZ 

decoder line A (B) must connect a 120 Ω resistance to reduce the reflection 
otherwise the PTZ control is not stable. 

8 The distance is too far. 
 
 
(12) The motion detect is not working, 

Possible reasons are as followed: 
1 The time range set is not correct. 
2 The motion detect area set is not correct. 
3 The sensitivity is too low. 
4 Limited by some hardware edition. 

 
 
(13) I cannot login via web or CMS. 

Possible reasons are as followed: 
1 The system is windows 98 or wins me. We recommend updating to windows 

2000sp4 or higher Version or installing the software for low edition. 
2 ActiveX is hold back. 
3 Network connection failure. 
4 Network setting issues. 
5 Invalid password or user name. 

 
 
(14) The image is not clear or there is no image in network preview state or video file 

playback state. 
Possible reasons are as followed: 

1 Network is not stable. 
2 The user machine is resource limited. 
3 Choose the play-in-team mode in the network setup of AHD DVR. 
4 The region shelter or channel protection is set. 
5 The user has no surveillance purview. 
6 The real-time image of the hard disk recording machine itself is not clear. 

(15) Network connection is not stable. 
Possible reasons are as followed: 
1 Network is not stable. 
2 IP address is conflicted. 
3 MAC address is conflicted. 
4 The net card of the AHD DVR is bad.  

 
(16) There is something wrong with the USB backup or writing a CD. 
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Possible reasons are as followed: 
1 The rewritable machine and the hard disk are shared the same data lines. 
2 The data is too much. Please stop recording and backup. 
3 The data exceeds the backup storage. 
4 The backup equipment is not compatible. 
5 The backup equipment is damaged. 

 
  
 
(17) Alarm cannot be recessional. 

Possible reasons are as followed: 
1 The setting of the alarm is not correct. 
2 The alarm output is turned on manually. 
3 The input machine is damaged or the connections are not correct. 
4 There are some problems for specific program edition, Please update the 

program. 
 
 
(18) Alarm is not working. 

Possible reasons are as followed: 
1 The setting of the alarm is not correct. 
2 The connection of the alarm is not correct. 
3 The alarm input signal is not correct. 
4 A alarm is connected with two loops synchronously. 

 
 
(19) The remote controller is not working, 

Possible reasons are as followed: 
1 The remote control distance is too far or the angle is too large. 
2 The battery is used up. 

3 The remote controller or the front panel of the recording machine is 
damaged. 

 
 
(20) The storage time is not enough. 

Possible reasons are as followed: 
1 The hard disk capability is not enough. 
2 The hard disk is damaged.  



62 
 

5.2 Maintenance 
 
 
 
(1) Please brush printed circuit boards, connectors, fans, machine box and so on 

regularly. 
(2) Please keep the grounding well done to prevent the video or audio signal interfered 

and the AHD DVR from static or inductive electricity. 
(3) Do not pull out the video signal line or RS-232 port or RS-485 port with the 

power on. 
(4) Do not use the TV in the local video output port (VOUT) of AHD DVR. It will 

damage the video output circuit easily. 
(5) Do not turn off the switch directly. Please use the turn-off function in the menu or 

press the turn-off button in the panel (3 seconds or longer) to protect the hard 
disk. 

(6) Please keep the AHD DVR away from heat resource. 
(7)Please keep the AHD DVR ventilated for better heat radiator. Please check the 

system and maintain regularly. 
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Appendix 1.Remote controller operation 
 
 
 
 
 

 
 

Serial 
no. 

Name Function 

（1） Multi-window button For view 4,view 8,view 9 and view 16 

（2） Numeric button Code input/ number input/ channel switch 

（3） 【Esc】 Same function as 【Esc】 button in the front 
panel 

（4） Direction button Same function as direction button in the 
front panel 

（5） ADD Input the number of DVR to control it 

（6） FN Assistant function 

（7） For playback 

 
 



64 
 

Appendix 2. Mouse Operation 
 
The mouse in USB connection is supportive. 
 
Take right hand as an example. 
 

Operation Function 

  

Double click one item in the 
file list to playback   Add or subtract number in 

the number setting 

the video Press middle 
button 

  
Double click the playback 
video to zoom in or out   Switch the items in the 

combo box 

the screen   

Double left 
click 

Double click the channel to 
make it full screen   

Page up or down in the list 

display   

  
Double click again to resume 

the multi-window Move mouse 
Choose the widget or 

move the item 

display In the widget 

Left click Choose the according 
function in the menu 

Drag mouse 
Set the motion detect area 

Right click Pop desktop short cut menu in 
preview state Set the cover area 

  Current short cut menu in the 
menu     
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INFORMATION ON E-WASTE HANDLING AND MANAGEMENT 

 
Dear Customer, 

 
The Ministry of Environment and Forests have published The E-waste 
(Management and Handling) Rules 2010 which comes in effect from 1st May 
2012. 
E-waste is defined as any electrical or electronic component of products in whole or in 
part, or rejects from their manufacturing or repair process which are intended to be 
discarded. 
These rules apply to every producer, consumer or bulk consumer involved in the 
manufacture, sale, and purchase and processing of electrical and electronic 
equipment or components as specified in Schedule 1 (please refer to our website 
www.godrej.com in the „Good & Green‟ section of CSR module for more details). 
Under these rules, specific roles and responsibilities are defined for 
producers, consumers and recyclers handling and managing E-waste. 
E-waste is to be managed in an environmentally sound manner which means, taking 
steps to ensure that health and environment are protected from adverse effects of 
hazardous substance contained in such wastes. 
Rule 6 of the E-waste (Management and Handling) Rules 2010 states that bulk consumers 
of electrical and electronic equipment shall be responsible for recycling of the e- waste 
generated by them. Bulk consumer means bulk users of electronic and electrical 
equipment such as Central Government or State Government Departments, public sector 
undertakings, banks, educational institutions, multinational organizations, international 
agencies, private companies that are registered under the Factories act 1948 and 
Companies act 1956. The bulk consumers have to ensure that the e-waste generated by 
them is channelized to authorized collection centers or is taken back by the producers. 
They shall maintain records of E-waste generated by them in Form 2 and make such 
records available for scrutiny by the State pollution control or the Pollution n control 
Committee concerned. 
All consumers of electrical and electronic equipment irrespective of their status as bulk 
consumers or not , shall ensure that E-waste generated by them is channelized to 
authorized collection center(s) or registered dismantler(s), or recycler(s) or is returned 
to the pick-up/take back services provided by the producers. (Please refer to our 
website 
www.godrej.com in the Good & Green section of CSR module for more details).               
All our products intended to be recycled under the category of E-waste (as defined 
above) carry a label or stamp of the WEEE symbol (A wheelie bin with a cross) , which 
states that it falls under the hazardous waste category and is not to be disposed along 
with normal garbage. 
We seek your support in ensuring environmentally sound management of E-waste and aid 
us in sustaining our earth‟s natural resources and maintaining the earth‟s green 
Cover intact for the benefit of our future generations. 
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